
 
   

 
  
  

 
 
 
  
  
  

 
  
  

Stellar Phoenix Mailbox Exchange Desktop 
  

Version 4.0 
  

User Guide 
  
  

 



 
   

Stellar Phoenix Mailbox Exchange Desktop 
  

 
 

Overview 
  
Stellar Phoenix Mailbox Exchange Desktop is a complete solution to convert Microsoft Outlook Offline Storage (OST) 
files to Microsoft Outlook Personal Storage (PST) files. 
  
What is OST File? 
If you use Outlook as an Exchange Server client and do not use PST file to store your data (instead store your data on 
the Exchange Server), OST file allows you to work offline. OST file acts essentially as an offline copy of your data 
store on the Exchange Server. When you're working offline, all changes that you make to contacts, messages, and 
other Outlook items and folders occur in the offline store. When you go online again, Outlook synchronizes the 
changes between offline store and your Exchange Server store. For example, if you've deleted messages from your 
offline store, Outlook deletes those same messages from your online store when you synchronize the folders. Any 
new messages in your Inbox on the server are added to your offline store. Synchronization is a two-way process, 
providing the most up-to-date copy of your data in both locations, ensuring that changes made in each are reflected in 
the other. 
An OST file is similar to a PST. The difference is that an OST file is RTF-aware, while a PST is not. The contents of 
any folder designated as an offline folder are included in the OST file, but the contents of the mailbox and other folders 
are not. 

Key features: 
• Enables user to view messages in 3-view format 
• Recovers e-mails, calendar entries, contacts, notes and journals 
• Restores formatting from RTF and HTML messages 
• Converted file is saved as new PST file on any (including network) disk visible by the host operating system 
• Creates unique profile for PST file 
• Supports MS Outlook 2000, 2002 (XP), 2003, 2007 
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Stellar Phoenix Update Wizard 
  
The Stellar Phoenix Update Wizard keeps your Stellar Phoenix Mailbox Exchange Desktop application updated. 
Update option in the application checks for the latest updates available online. Stellar Phoenix Update Wizard checks 
for latest minor and major version available online. Stellar Phoenix Update Wizard automatically installs the minor 
version, if available. However, if major version available then you need to purchase it. While updating the software, it’s 
recommended to close all the running programs. 

To start Stellar Phoenix Update Wizard: 

1. In the Stellar Phoenix Mailbox Exchange Desktop screen, Click Update Wizard  icon. the Stellar Phoenix 
Update Wizard window opens, click Next. The wizard will start searching for the latest updates and if it finds any 
new version, a window pops up indicating the availability. 

2. Click Next, the software will start downloading files from the server. When the process is complete, the software 
will upgrade to the latest version. 

Live Update may not happen due to following reasons: 
• Internet connection failure 
• Updates are not available 

  

 If major version is available, to upgrade the software you have to purchase it. 
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Getting Started 
  
Stellar Phoenix Mailbox Exchange Desktop software converts OST files to PST files and saves them to your preferred 
location. It also shows content of converted OST file in a three-pane structure. When the scanning process is 
completed, all the recovered emails, notes, journals, tasks, calendar entries and contacts can be viewed in Stellar 
Phoenix Mailbox Exchange Desktop window. You can save the recovered PST file to your location.  
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Installation Procedure 
  
Before installing the software, ensure that your system meets the minimum system requirements: 

Minimum System Requirements 
• Processor: Pentium Class 
• Operating System: Windows NT4(SP6)/2000/XP/2003/Vista/Windows7 
• Memory: Minimum 256 MB (512 MB recommended) 
• Hard Disk: 50 MB of free space 
• MS Outlook: 2000, 2002 (XP), 2003, 2007 
• Internet Explorer: Version 6 or later 

To install the software: 
1. Double-click spmde.exe file to start the setup process. The Setup - Stellar Phoenix Mailbox Exchange Desktop 

dialog box opens. Click Next. 
2. In the License Agreement screen, select I accept the agreement option. The Next button will be enabled. Click 

Next. 
3. In the Select Additional Tasks screen, check the required check boxes. Click Next. 
4. In the Select Destination Location screen, provide the path by using Browse button where the setup files will be 

stored. Click Next. 
5. In the Start Menu Folder screen, provide the path by using Browse button where the program's shortcuts will be 

stored. Click Next. 
6. In the Ready to Install screen, review the settings. Click Back to change settings. After confirming the settings, 

click Install. The Installing screen shows the installation process. 
7. After completing the process, the Completing the Stellar Phoenix Mailbox Exchange Desktop Setup Wizard 

screen opens. Click Finish. 

Starting the Software 

To start the application, do one of the following: 
• Click Start | All Programs | Stellar Phoenix Mailbox Exchange Desktop, and then click Stellar Phoenix 

Mailbox Exchange Desktop. 
• Double-click the shortcut icon of Stellar Phoenix Mailbox Exchange Desktop from the desktop. 
• Click quick launch icon on the taskbar. 

  You can clear the Launch Stellar Phoenix Mailbox Exchange Desktop check box to stop the automatic launch of the software. 
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How to Order 
  
The software can be purchased by making payments online by using a credit card. Please visit 
http://www.stellarinfo.com/exchange-ost-recovery-prices.htm?Order for more information and to place an order. 
Alternatively, if the demo version is installed then on the Help menu, select Order Stellar Phoenix Mailbox 
Exchange Desktop. This will open the home page of Stellar Phoenix Mailbox Exchange Desktop from where you can 

purchase the software. You can also click Order Stellar Phoenix Mailbox Exchange Desktop  on the toolbar. 
The Order Stellar Phoenix Mailbox Exchange Desktop opens, click the Buy Stellar Phoenix Mailbox Exchange 
Desktop link to visit the home page from where you can purchase the software. 
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How to Register 
  

 If the software is downloaded from http://www.stellarinfo.com/exchange-ost-recovery-prices.htm?Order  (i.e., ESD version), for the full 
functionality, the product must be registered using Serial Number (received through email after purchasing the product). 

If the software is installed using the product installation CD (i.e., BOX version), hardware lock  is mandatory for the functioning of the 
software that is available with the software kit. 
  
  
After purchasing the software, you will receive the serial number, which is required to register the software. The serial 
number will be verified during the registration process and if the serial number is valid then the software will be 
registered. 
The software can be registered in different ways. These are the methods by using which you can register the 
software: 
  

• Over internet 
You should have the serial number, which is received after purchase of the software. On entering the 
serial number it is verified by license server and on verification the software will be registered. 
  

• Manual Activation 
You will need to generate a PHX_REG.txt file and mail the .txt file to support@stellarinfo.com. After 
verifying the serial number and purchase details of the software, the site key will be delivered to you at 
your email address. This site key is used to register the software manually. 
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Registration Over Internet 

To register the software over Internet: 
• On the Activation menu, click Activate Stellar Phoenix Mailbox Exchange Desktop Online. The Warning 

dialog box opens, click OK. 
• In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click Next. 
• Type the Serial number (received through email after purchasing the product) in the Serial number text box. 

Click Next. 
  

 
  

• The software would automatically communicate with license server and register the software. Click Finish to 
complete the registration process. 

  
  

 You can generate the PHX_REG.txt file manually by starting the online activation. View manual activation topic to perform the process of 
generating PHX_REG.txt file. 
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Manual Activation 

To register the software by using manual activation process: 
• On the Activation menu, click Activate Stellar Phoenix Mailbox Exchange Desktop Online. The Warning dialog 

box opens, click OK. 
• In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click Cancel. 
• The Stellar Phoenix Mailbox Exchange Desktop dialog box opens, click OK. 

  

 
  

• In the Stellar Phoenix Mailbox Exchange Desktop -Manual Software ... dialog box, enter the serial number, 
which is received after the successful purchase of the software. Click Next. 

  

 
  

• A file named PHX_REG.txt will be created at your desktop. Email the .txt file to support@stellarinfo.com email 
address. Click Finished. 

  

 
  

• In reply, you will receive the site key after checking the purchase details. This site key is required to activate the 
software manually. 



 
   

• When you receive the site key, open Stellar Phoenix Mailbox Exchange Desktop, on the Activation menu, click 
Manual Registration. In the Stellar Phoenix Mailbox Exchange Desktop dialog box, enter the site key, which is 
received after sending the PHX_REG.txt file. Click Validate. 

  

 
  
  

 The site key is delivered to your email address, which is used to sent the serial number. 
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User Interface 

Stellar Phoenix Mailbox Exchange Desktop has a rich Graphical User Interface (GUI) with many features. GUI of  
Stellar Phoenix Mailbox Exchange Desktop resembles the GUI of Microsoft Outlook. Stellar Phoenix Mailbox 
Exchange Desktop has a two-pane structure. The left-pane has Mail, Calendar, Contacts, Tasks, Notes and General 
tabs. Click a tab to view contents of it. All information related to an email such as sender's and recipient's address, 
subject date, and content is shown in the right-pane. The main user interface is as shown below. 

 
  
When you start Stellar Phoenix Mailbox Exchange Desktop then Select Outlook Data File dialog box as shown below 
opens. You can select and search OST file by using this dialog box. 

  

 
  

In this dialog box, the Select Outlook File button is used to select OST file from known location. The Find Outlook File 
button is used to search OST file in volumes. Start button starts conversion process. 
Stellar Phoenix Mailbox Exchange Desktop has a toolbar and menubar having many options. 

 Select Outlook Data File dialog box can also be opened by selecting Open Outlook File on the File menu  and by clicking the Open 
Outlook File to Repair icon from toolbar. 
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Menubar 
  
Menubar of Stellar Phoenix Mailbox Exchange Desktop has these menus and items: 
  

Menu Items 

File 
o Open Outlook File: Opens Select Outlook Data File dialog box that allows you to 

search and select OST files. 
o Exit: Close Stellar Phoenix Mailbox Exchange Desktop application 

View 

o View Log Report: Shows log report generated by Stellar Phoenix Mailbox Exchange 
Desktop's processes. 

o View Recovery Details: Shows folders and number of files recovered from the selected 
OST file. 

Activation 

o Activate Stellar Phoenix Mailbox Exchange Desktop: Starts the process of activating 
Stellar Phoenix Mailbox Exchange Desktop by using Internet. 

o Manual Registration: Starts the process of manual activation of Stellar Phoenix 
Mailbox Exchange Desktop. 

  

Help 

o Help Topics: Opens help guide of Stellar Phoenix Mailbox Exchange Desktop. 
o Order Stellar Phoenix Mailbox Exchange Desktop: Provides information regarding 

the purchase of Stellar Phoenix Mailbox Exchange Desktop. 
o View Support Section: Opens online support web site where you can get online 

support. 
o View Knowledge Base: Opens knowledge base web site where you can find numerous 

number of knowledge base articles related to software. 
o Submit a Ticket: Allows you to submit a ticket to online support web site such that your 

query can be solved effectively. 
o About Stellar Phoenix Mailbox Exchange Desktop: Provides general information and 

End User License Agreement (EULA) of the Stellar Phoenix Mailbox Exchange Desktop.
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Toolbar 
  
Stellar Phoenix Mailbox Exchange Desktop has a toolbar with these tools: 
  

• : Opens Select Outlook Data File dialog box using which you can select and find OST files in your 
computer. 

• : Allows you to save converted PST files at your preferred location. 

• : Switch Reading Pane icon changes right pane position. When you click a folder in left-pane, by default, 
the right pane shows details in horizontal columns position. You can click icon to change the position to vertical 
columns. 

• : Opens help guide of Stellar Phoenix Mailbox Exchange Desktop. 

• : Update Wizard checks of available updates for Stellar Phoenix Mailbox Exchange Desktop. Click this icon 
to run update wizard, which downloads and installs newly available updates for Stellar Phoenix Mailbox 
Exchange Desktop. 

• : Provides general information and End User License Agreement (EULA) of Stellar Phoenix Mailbox 
Exchange Desktop software. 

• : Provides information regarding the purchase of Stellar Phoenix Mailbox Exchange Desktop. 
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Converting OST to PST 
  
If the location of OST file is known then you can directly specify the location and start conversion process of OST to 
PST. If you do not know the location then you can search the required OST file by using the search functionality of 
Stellar Phoenix Mailbox Exchange Desktop. 

To convert OST files: 
1. In the Stellar Phoenix Mailbox Exchange Desktop screen, on the File menu select Open Outlook File or click  

 icon to open the Select Outlook Data File dialog box and click Select Outlook File.  If file location is not 
known then search OST files in drives and folders and select the required OST file. 

2. In the Open dialog box, locate and select the OST file that needs to be converted and click Open. Click Start 
button to start scanning selected OST file. It may take few minutes to few hours to complete the scanning 
process depending on the size of the selected OST file. You can stop scanning process by clicking the Stop 
button, which appears after clicking Start button. 

  

 
  
After completion of scanning process, Stellar Phoenix Mailbox Exchange Desktop summary dialog shows recovery 
process details that is how many Emails, Calendar entries, Contacts, Tasks, Notes and Journals are recovered. Click 
Close. You can also view recovery details by selecting View Recovery Details from View menu. 
  

 
  



 
   

 After successful completion of scanning process, all recovered folders with number of files in them will be listed in the left-pane under root 
node. Click a folder to view emails stored in it. Click an email to read it. In addition, Mail, Calendar, Contacts, Tasks, Notes, and Journal tabs are 

given, click a tab to view its contents. You can also change reading pane from horizontal to vertical. Click  icon to change reading pane 
position. 
  

Click save pst files  icon, the Stellar Phoenix Mailbox Exchange Desktop box opens, click Browse. in the Browse 
for Folder dialog box, locate and select the location where PST file should be saved. Click OK twice. 
  
PST file will be saved at the specified location. You will need to import the recovered PST file to Microsoft Outlook to 
use it. 

You can stop scanning process and recovering process individually. If you stop scanning process then no file will be recovered. If you stop 
recovering process then only files recovered up to stopped point will be displayed. Also, Microsoft Outlook should be closed before starting 
scanning process. Recovery of deleted data is not possible after performing compacting or Archiving operation. 
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Searching OST Files 
  
You can search for OST files by using Find Outlook File functionality of Stellar Phoenix Mailbox Exchange Desktop. 
You can search OST files in drives, folders and sub folders. However, you can select only one drive to search OST 
files. 

To search OST files in drives: 

• On the File menu, select Open Outlook File or click  icon on the toolbar to open Select Outlook Data File 
dialog box. 

• In Select Outlook Data File dialog box, click Find Outlook File button. 
• In the Find OST File dialog box, under Search Options box, click Look in listbox to select drive. Select the 

required drive, and then click Start. 
  

 
  

• In the Find OST File dialog box, under Search Results box, all OST files that are found in the selected drive will 
be shown. Click a file to select, and then click OK. 

  

 

 You can click Clear List button to clear the result of search process and start a new search process. 

To search OST files in folders and subfolders: 

• On the File menu, select Open Outlook File or click  icon on the toolbar to open Select Outlook Data File 
dialog box. 

• In the Select Outlook Data File dialog box, click Find Outlook File button. 
• In the Find OST File dialog box, click Search in folder button. In the Browse for Folder dialog box, select a 

folder and click Start. In addition, if you want to search subfolders in that folder, check Search Subfolders 
checkbox. 

• In the Find PST File dialog box, under Search Results box, all OST files that are found in the selected drive will 
be shown. Click a file to select, and then click OK. 
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Import PST File 
  

To import PST file in Microsoft Outlook: 
• Open Microsoft Outlook. On the File menu, select Import and Export. 
• In the Import and Export Wizard, select Import from another program or file, click Next. 
• In the Import a File box, select Personal Folder File (PST), click Next. 
• Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. 

Click Next. 
• In the Import Personal Folders dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 
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Saving Log Report 
  
You can save record of all processes of Stellar Phoenix Mailbox Exchange Desktop in a text file. 

To save log report: 
1. On the View menu, select View Log Report. 
2. In the Stellar Phoenix Mailbox Exchange Desktop box, click Save Log. 

 
  

3. In the Save As dialog box, specify the location where log file should be saved. Click Save. 

To clear log report: 
1. On the View menu, select View Log Report. 
2. In the Stellar Phoenix Mailbox Exchange Desktop box, click Clear Log. 
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Copyright 
  
Stellar Phoenix Mailbox Exchange Desktop software, accompanied user manual and documentation are copyright of 
Stellar Information Systems Ltd., with all rights reserved. Under the copyright laws, this user manual cannot be 
reproduced in any form without the prior written permission of Stellar Information Systems Ltd. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA 
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Disclaimer 
  
The Information contained in this manual, including but not limited to any product specifications, is subject to change 
without notice. 
STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO THIS MANUAL OR 
ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO 
ANY OF THE FOREGOING STELLAR INFORMATION SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY 
DAMAGES INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 
MANUAL. IN NO EVENT SHALL STELLAR INFORMATION SYSTEMS LTD, BE LIABLE FOR ANY INCIDENTAL, 
CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED ON TORT, CONTRACT OR 
OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION 
CONTAINED HEREIN OR THE USE THEREOF. 
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License Agreement 
  
Stellar Phoenix Mailbox Exchange Desktop 
Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA 
www.stellarinfo.com 
All rights reserved. 
All product names mentioned herein are the trademarks of their respective owners. 
This license applies to the standard-licensed version of Stellar Phoenix Mailbox Exchange Desktop. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this software, 
unless you have a different license agreement signed by Stellar Information Systems Ltd. 
If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or use any 
copy of Stellar Phoenix Mailbox Exchange Desktop with which this License is included, you may return the complete 
package unused without requesting an activation key within 30 days after purchase for a full refund of your payment. 
The terms and conditions of this License describe the permitted use and users of each Licensed Copy of Stellar 
Phoenix Mailbox Exchange Desktop. For purposes of this License, if you have a valid single-user license, you have 
the right to use a single Licensed Copy of Stellar Phoenix Mailbox Exchange Desktop. If you or your organization has 
a valid multi-user license, then you or your organization has the right to use up to a number of Licensed Copies of 
Stellar Phoenix Mailbox Exchange Desktop equal to the number of copies indicated in the documents issued by 
Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Mailbox Exchange Desktop may either be used by a single person or used 
non-simultaneously by multiple people who use the software personally installed on a single workstation. This is not a 
concurrent use license. 
All rights of any kind in Stellar Phoenix Mailbox Exchange Desktop, which are not expressly granted in this license, 
are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You may not rent, lease, modify, 
translate, reverse engineer, decompile, disassemble or create derivative works based on Stellar Phoenix Mailbox 
Exchange Desktop nor permit anyone else to do so. You may not make access to Stellar Phoenix Mailbox Exchange 
Desktop available to others in connection with a service bureau, application service provider or similar business nor 
permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations. 

Stellar Phoenix Mailbox Exchange Desktop and all accompanying software, files, data and materials are distributed 
and provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there is no 
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates that any 
program including Stellar Phoenix Mailbox Exchange Desktop must be thoroughly tested with non-critical data before 
there is any reliance on it and you hereby assume the entire risk of all use of the copies of Stellar Phoenix Mailbox 
Exchange Desktop covered by this License. This disclaimer of warranty constitutes an essential part of this License. 
In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Mailbox Exchange Desktop in 
applications or systems where its failure to perform can reasonably be expected to result in a significant physical injury 
or in loss of life. Any such use is entirely at your own risk and you agree to hold Stellar harmless from any and all 
claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and merges and 
supersedes all other or prior understandings, purchase orders, agreements and arrangements. This License shall be 
governed by the laws of the State of Delhi, India. Exclusive jurisdiction and venue for all matters relating to this 
License shall be in courts and for a located in the State of Delhi, India and you consent to such jurisdiction and venue. 
There are no third party beneficiaries of any promises, obligations or representations made by Stellar herein. Any 



 
   

waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any 
other or future violation of the same provision or any other provision of this License. 
Copyright ©1995-2009 by Stellar Information Systems Ltd. All rights reserved. 
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Trademarks 
  
Stellar Phoenix Mailbox Exchange Desktop® is a registered trademark of Stellar Information Systems Ltd. 
Windows 2000 Server®, Windows XP®, Windows 2003®, Windows Vista®, MS Office and MS Outlook are registered 
trademarks of Microsoft® Corporation Inc. 
All Trademarks Acknowledged. 
All other brands and product names are trademarks or registered trademarks of their respective companies. 
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Technical Support 
  
Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 
You can either Call Us or Go Online to our support section http://stellarinfo.com/esupport/users/kb.php 
  

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Toll free - Pre Sales Queries) 1-866-554-2512 
USA (Post Sales Queries) 1-315-220-6245 
UK (Europe) +44-207-993-2293 
Germany +49-180-110-105-0051 
Worldwide +91-921-395-5509 
Skype Id stellarsupport 
Email Orders orders@stellarinfo.com 

Online Help 
� Chat Live with an Online technician 
� Search in our extensive Knowledge Base 
� Submit Ticket (If our Knowledge Base does not answer your question) 
� Login and view Ticket Status (If you already have a valid Ticket with you) 
� Download Documents on Product Usage ( For Registered members only, i.e, user with login ID. If you are an 

unregistered user, please visit http://stellarinfo.com/esupport/users/login.php to create login ID) 
 



 
   

Stellar Phoenix Mailbox Exchange Desktop 
  

 
 

About Stellar 
  
Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data Protection Software for more 
than a decade. 
We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for almost all 
Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental format, virus 
problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair tools. More 
Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook Express and 
MS Exchange useful in instances of data loss due to damages and corruption of Email. More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure complete data 
protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, System Traces & 
Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser utility, it is beyond recovery 
limits of any Data Recovery Software or utility. More Info >> 
For more information about us, please visit www.stellarinfo.com 
 
 

  


